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Revision History:

January 10, 2006: First Edition (Survey Response Tools Ver. 3.00 compliant)

Jun 9, 2006: Second Edition (Survey Response Tools Ver. 3.11 compliant) — There are no alterations to the content
of this manual.
Changes to Survey Response Tools Ver. 3.11 (applicable to both Standard and Detailed)
(1) Five items added to intended use classification (Pb-R-10, 11, 12, 13, 14).
(2) Deactivation of the drag-and-drop editing feature has been discontinued.
(3) Number of copies to be printed when clicking on the “Part List Print” button has been
changed from two to one.
March 12, 2007: Third Edition (Survey Response Tools Ver. 3.23 compliant)
Major changes to Survey Response Tools Ver. 3.23 (applicable to both Standard and Detailed
with some exceptions)
(1) Ten items added to intended use classification (Cd-R-3, Cr-R-2, Pb-R-15-22).
(2) Specification of required data fields (11 fields).
(3) Limitation in the number of text entry (length of character string) has been extended (17
fields).
(4) Other improvements in functions
(For details, see the document in the website: Specifications Overview of Survey Response
Tools Ver. 3.23)
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Note:

Based on the Material Composition Survey and Response Manual, the Survey Response Tools Operation Manual
describes operation and data input procedures relating to electronic data exchange by means of e-mail using a
computer.
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1. Features of Survey Response Tools Ver. 3
(1) Tool Types

There are two types of Survey Response Tools available. jgp files created by each tool have different
extensions to differentiate from each other.

- Survey Response Tool Format 1 (Standard Type) Ver3. XX — jgpl file (extension jgpl)
- Survey Response Tool Format 2 (Detailed Type) Ver3. XX — jgp2 file (extension jgp2)

Note: There is no tool to confirm the data.
(2) Relationship of Data Input/Output between Tools

1) Detailed data can be converted into standard data when loaded with a standard tool (restrictions apply:
refer to p. 21 for details). However, standard data cannot be converted into detailed data.

2) Data in the old formats (Ver. 1 and Ver. 2) can be loaded with Ver3.XX tools (restrictions apply: refer to
p. 23 for details).

(3) New Functions

1) Error Check: Automatically checks data entered on each screen and displays error and warning

descriptions.
Primary checking items:
- Checking missed entries - Checking data misalignment
- Checking dates - Checking single byte/double byte characters

- Checking the number of characters and digits
2) Sorting: You can sort data by using a condition of each surveyed item as a key.
3) Print screen: You can print screens showing basic information, products/subparts/material information
or information on material composition of products.
4) Others: You can load additional jgp files.

2. Supported Operating Systems and Software

(1) Supported Excel Versions
Excel 2000 for Windows
Excel 2002 for Windows
Excel 2003 for Windows

* Excel and Windows are registered trademarks of Microsoft Corporation in the United States and other countries.

(2) Supported Operating Systems: Windows supporting the above Excel versions
(Windows 2000 and Windows XP)

(3) Language Combination
- Tools in Japanese version: Japanese Excel and Japanese operating systems
(jgp files created with English tools can also be loaded.)

- Tools in English version: English Excel and English operating systems, Japanese Excel and Japanese

operating systems
(You can use tools in English version with Japanese operating environment.)
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3. Downloading Tools

Both formats of Survey Response Tool Ver. 3 are available free of charge and open to public at JGPSSI
website. You can download and save onto your computer for personal use.

JGPSSI website: http://210.254.215.73/jeita_eps/green/009.html

- Survey Response Tool Format 1 (Standard Type) Ver3. XX .xls :1
- Survey Response Tool Format 2 (Detailed Type) Ver3. XX.xls '

*1. The tools may be revised to comply with applicable laws or function modifications. Before use, make sure
that the tool you downloaded is the latest version.

4. Creating Survey Request Data (jgp file) by Survey Requester

4.1 Starting Survey Response Tools

The survey requester selects a survey response tool to be used. Then start Excel and choose “Enable
Macros” to open a screen.

Note: Set the macro security level to “medium” to use the tool.
If the security level is set to “high,” the warning below appears. Click OK and then the warning will
disappear, but the tool cannot be used. From Tool in the Excel main menu change the macro security level

to “medium” in the macro security screen and exit Excel. Then start Excel again and open the tool once
more.

Display Example in Windows XP:
Microsoft Excel il

Macros are disabled because the security level is set to High and a digitally signed Trusted Certificate is nok
attached to the macros. To run the macros, change the security level to a lower setting {not recommended), or
request the macros be signed by the author using a certificate issued by a Certificate Autharity.

Hide Help <« Cpen in Help window

F
“ou may encounter this error for the following reasons: |

1.  Macro security is set to:
. Wery High and the application encounters a signed macro, but the macro was automatically disabled,
Use the Fallowing procedure ko enable the macra:
1. Select the Tools menu option and then select Macro and Security. In the resulting Security
dialog, set the security level o High by clicking the High radio button,
2.  Close the file and any other instances of the application currently running on the computer {close
all applications that also use the application wou are currently Funning). LI

2 miman Fha Fila anain and cwamina Fha cavkbificabka oF Feock dabsile and cal Fha il aesc Feack

If the following security warning appears, click Enable Macros.

Security Warning ﬂ

"Dy IGPasGreensurvey Tooly300-F1-060106. x|s" contains macros.,

Macros may conkain viruses, It is usually safe ko disable macros, buk if the
macros are legitimate, vou might lose some Functionality.

Disable Macros I Enable Macros More Info
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After that, the following screen appears. (Ver.3.23)

Green Procurement Survey Tool

Format 1(Standard Type)Ver3.23 commoessanecsats (0010P)  (oowee ) (s (Erorcontmaion ] (s ] (panistprn )

Basic Information about Company

Reference Nuber [Respondens dete of Galaenty (VYYWWDD] | 1]
[Date of Dt Entry YYYYMIWIDD] 1

— — T —
Engish

o] o]
o) | o) g

Requesirs | Reduesters | Requesirs
lemt liem2 leng

Respondos | Respondts | Responents
Rponden s Aot o em3 isonDale | Suveying | Suvey UritMass ot Copy Clear

Rer
productsubprts | productiubparts DalaVerson | yyvymman | unt (gunit) | ContentFlag | substances | substances | substances

Mot G| et Tipe
o It rumber | e rame

Somogy | N, [Ticaessom) - Coer Diameter(r)

it e
number o equester Name

EEEEEEEEEEEEEIEERE

4.2 Entering Basic Information (same procedure for both tools)

Based on p. 5 in the Material Composition Survey and Response Manual (hereafter “Survey Response
Manual”), the requester enters information on the survey requester in the fields displayed at the top left on the
tool screen.

Green Procurement Survey Tool
Format 1(Standard Type)Ver3.23 Copyright(C) JGPSSI & NEC Soft, L

Basic Information about Company

Reference Number Data Format Ver. | 3.21 |
Date of Data Entry (YYYY/MM/DD)

Requester Information English
Company Name

DUNS Number

Division Name

Contact Name

Telephone Number

Fax Number

Email Address

Requester's management items 1
Requester's management items 2
Requester's management items 3

Example
Reference Number A100001 Data Format Ver. | 3.21 |
Date of Data Entry (YYYY/MM/DD) 2005/03/15
Requester Information English
Company Name ABC Inc.
DUNS Number R
Division Name % department
Contact Name XX YY
Telephone Number ()3 _EwR
Fax Number (3 FEF
Email Address abc@abc.com

Requester's management items 1
Requester's management items 2
Requester's management items 3
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4.3 Entering Information on Surveyed Items (same procedure for both tools)
Enter information on a survey request item under the basic information section on the screen, based on pp. 6-7
in Survey Response Manual, as appropriate. The pink cells are required fields and the product/subpart number
of requester is required if there is no entry in the six fields which are used when the surveyed item is a material
(see the table below).

Caution: <Condition to save in jgp file>

When none of the seven fields (pink cells) below which identify the surveyed item are entered, the

data of the applicable line will not be saved in jgp file. However, even when none of the seven fields

are _entered, the data of the applicable line can be saved, if either Manufacturer name or

Respondent’s product/subpart/material number shown in 5.2 (2) on Page 11 is entered.

Information about Parts/ Products/ Material

Ascen| (Desce]
ding ) \nding

Ascen| (Desce
ding ) \nding

Product / . Requester's Requester's Requester's
No. (FrelE A subpart/material VEENE GRED)| - WEE e Coloring No. | Thickness(mm) Color Diameter(mm) |—ltem? ltem2 lemd |
number of requester No. JIS symbols
name of requester
1
2
3]
7
5]
Example: Subparts (Capacitor)
Information about Parts/ Products/ Material
Ascen| (Desce Ascen| (Desce|
ding ) (nding ding ) |nding
Product / Requester's Requester's Requester's
Product/subpart . Material Grade | Metal Type . . . ltem1 ltem2 ltem3
No. nUmber of requster subpart/material No. JIS symbols Coloring No. | Thickness(mm) Color Diameter(mm) Speciication
name of requester -
1]ABC-123 Capacitor A ABC-
2|ABC-124 Capacitor B ABC-
3[ABC-125 Capacitor C ABC-
7
5]
Example: Materials (Plastics)
Information about Parts/ Products/ Material
Ascen| (Desce Ascen| (Desce|
ding ) (nding ding ) |nding
Product / Requester's Requester's Requester's
Product/subpart . Material Grade | Metal Type . . . ltem1 ltem2 ltem3
No. nUmber of requester subpart/material No. JIS symbols Coloring No. | Thickness(mm) Color Diameter(mm) Speciication
name of requester -
ABS A100-XXX 12345 White

SEMEISE

4.4 Saving jgp Files

Click SAVE JGP button at the top of the screen.

When the message “Do you want to run an error check?” appears, click No.

Caution: If you press Yes to run an error check, an error description appears as respondent’s information
(required data fields) has not been entered. When making a jgp file for survey request using SAVE
JGP button, please do not run an error check.
However, please read the Caution: <Condition to save in jgp file> in 4.3.
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If the error check detects no error, the following screen appears. Choose a folder to save the file. Then name
the file to save. Each tool automatically adds the appropriate extension, jgpl or jgp2, based on the tool type.
Format 1 (Standard Type) takes an extension jgp1, and Format 2 (Detailed Type) takes jgp2.

The following screen illustrates an example of Survey Response Tool Format 1 (Standard Type).

The file type is automatically set to jgpl.

FileSave 2=
Savein: |3 JGPSSI = = =% Ef-

File name: ISur'-.-'e_l,lFI equestaBC-001| ;I Sawve I
Save as type: |IGP1Filesi*.jop1] -] Cancel |
F

When the following screen appears, click OK. Now the jgp file is successfully saved.

Microsoft Excel : x|

The file has been saved successFully,

4.5 Exiting Survey Response Tools
From the toolbar, choose File > Finish or Close.
The following screen appears. If you choose Yes, the data you entered overwrites the old data and will be

saved in the tool.

Microsoft Excel x|

& Do wau wank ta save the changes you made ko 'Greensurvey Toalv300-F1-060106, xs'?

Mo | Cancel |

4.6 Sending jgp Files to Survey Respondent (Survey Request)

The survey requester sends a jgp file that includes basic information and information on surveyed items to the
respondent.

Note: As a rule, the requester and respondent should use a jgp file to exchange data.
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5. Creating Survey Response data (jgp file) by Respondent

5.1 Loading Data from Survey Requester (LOAD JGP)
(1) Save the jgp file that includes survey request data on your computer.

(2) Confirm the type of jgp file you received from the requester, and then choose the appropriate survey
response tool to open it.

If the jgp file you received from the requester has an extension of jgp1, choose Format 1 (Standard Type)
Ver. 3.XX; if the jgp file has an extension of jgp2, choose Format 2 (Detailed Type) Ver. 3.XX.

However, if you are going to create a response in Standard format, you can load jgp2 data in Format 1
(Standard Type) Ver. 3.XX (for further details, refer to p. 21 in this Operation Manual).

Note: Set the macro security level to “medium” to use the tools.
If the security level is set to “high,” the following warning appears. The warning will disappear if you
click OK, but the tools cannot be used. From Tool in the Excel main menu, change the macro security

level to “medium” and exit Excel. Then restart Excel and open the tool again.

Display Example in Windows XP:
Microsoft Excel |

attached to the macros. To run the macros, change the security level to a lower setking {not recommended), or

:j Macros are disabled because the security level is set to High and a digitally signed Trusted Certificate is nok
request the macraos be signed by the author using a certificate issued by a Certificate Autharity.

Hide Help <= Cpen in Help \Window

F
‘You may encounter this erraor for the following reasons: j

1. Macro security is set ko
+  ‘ery High and the application encounters a signed macro, but the macro was automatically disabled.
Ilse the Following procedure ko enable the macro:
1. Select the Tools menu option and then select Macro and Secuarity. In the resulting Security
dialog, set the security level to High by clicking the High radio button,
2. Close the file and any other instances af the application currently running on the computer {close
all applications that also use the application wou are currently running). ;I

] imiman Fha Fila sasin and awvamina Fha caekificaka =F Feock dakaile and cak Fha Alieaoec Fenck

When the following security warning appears, click Enable Macros.

Security Warning il

"0 JGPSSIEreenSurvey Tooly300-F1-060106. xls" contains macros.

Macros may conkain viruses, It is usually safe to disable macros, but if the
macros are leqitimate, you might lose some functionality,

Cisable Macros Enable Macros Mare Info
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Then the following screen appears. Example of Format 1 (Standard Type):

Green Procurement Survey Tool

Format 1(Standard Type)Ver3.23 — I CERES erwcteck | (EroCorimaton ) (st (et
Basic Information about Compan
]
e o] ] o] ] o T o] o] =
g5 e M BlElEE o)
o] Reqesrs | Remeders | Reqesers P R— RS

Podetityat e G| Mot | o ’ . ot | tonp | oy | Mutairer ot o2 iy | ReiinDale| Suveyrg | SuveyUnthss | Owal | o

Mo mberof requester "mm’;:v No. | JSsmbo | CoomaNe. | Ticknessmm)  Color i Name ""‘"“‘”":“’"::"m“m DalaVersion | yvyon | unit (gont) | ContentFlag | subsiances

ggggggﬁiﬁiﬁ%é’

luuuuuuuu@ %?

(3) Click LOAD JGP button at the top of the screen. The screen below appears. This is an example of Survey
Response Tool Format 1 (Standard Type).
The file type is automatically set to jgp1.
(Change the file type to jgp to load data from old format files.)

Open File

Lok jr: | (3 JGPSSI

| = E cx E-

21 x|

AF .jgp
ABCO01-02.igpl
ABCO01-03.igpl

File hame: I.-'l'-.EI Co01-01.jgpl

Filez aof type: I IJGF"‘I Files[*.jgp1] I

Iv Open as jead-only

=
The screen below is an example of Survey Response Tool Format 2 (Detailed Type).
The file type is automatically set to jpg2.
(Change the file type to jgp to load data from old format files.)
2 x|

Laak jr |ﬁ JGPSSI

= « ®= ok E-

ABCO0Z-23,jgp2
ABCO0Z-24.japE

File name: I.&E CO0Z-22.jap2

Files af tupe: I IJGPzFiles[*.igpz] I

v Open az read-anly




Next, choose the jgp file to load, and then click Open.
After the Survey Response Tool loads the survey request data, the following screen appears. Click OK.
Microsoft Excel |

The file has been loaded successFully.

As shown below, the information regarding the requester and surveyed items are loaded.

The items displayed for both Format 1 (Standard Type) and Format 2 (Detailed Type) are identical.

Green Procurement Survey Tool
Format 1(Standard Type)Ver3.23

Copyright(C) JGPSSI & NEC Soft, Ltd. | "

Basic Information about Company

[Reference Number

[A100001 [Data Format Ver. | 3.21 ]

Date of Data Entry (YYYY/MM/DD) ]2005/03/15 |
Requester Information English
Company Name ABC Inc.

UNS Number oo
Division Name **x department
Contact Name XXYY
Telephone Number

Q3 rmr_wrrE

Fax Number

|Email Address

Requester's management items 1
|Requester’'s management items 2
|Requester’s management items 3

O3
abc@abc.com

Information about Parts/ Products/ Material

Ascen| [Desce

Ascen| (Desce
ding nding

ding nding
Product / .
No. IPrealnsSuETeT ! subpart/material LacialCiacs i THEe Coloring No. Thickness(mm) Color
number of requester No. JIS symbols
name of requester

; ABC-001 Large size Switch Unit

3

s

5.2 Items to Be Entered by Respondent (Basic Information, Surveyed Item Information, etc.)

(1) Entering Information on the Respondent (Pink cells are required fields.)

Enter respondent’s information, such as company name (refer to pp. 5-6 in Survey Response Manual).
Example:

|Respondent's date of data entry (YYYY/MM/DD) |

Respondent Information

English

Company Name
DUNS Number

abc inc.

TREREHRE

Address

TEER

, minato-ku, Tokyo
Division Name abc dept.
Contact Name Mike Md.
Telephone Number 03_Feww_wwwe
Fax Number 037 FFRwwE
Email Address

Xyz@xyz.com

Requester’'s management items 4

Requester’'s management items 5

Requester's management items 6
Additional information regarding survey responses

Note : As a rule, the requester’s management items are entered by the requester. Do not change the
pre-entered data, if any.

(2) Enter manufacturer name, number, and name of the respondent (refer to p. 7 in Survey Response Manual).
The respondent’s items 1, 2, and 3 can be used as a memo pad.
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Example:

Respondent's Respondent's Respondent's Respondent's Respondent's
MEMUE G product/subparts | product/subparts ltem1 ltem2 ltem3
Name : .
/material number | /material name
XXX Electronics |abc-123 Switch Unit

(3) Enter the data version and revision date. If there is no information available for the data version, leave it
blank.

(4) Choose a survey unit and enter a total mass per unit.
- Choose a survey unit in the pull-down menu.
- Enter a total mass for the preset survey unit in “g.”
Example: If the survey unit is “piece” — mass for a surveyed item
If the survey unit is “kg” — mass per kg = 1,000g

Example:
Data Version Revision Date Surveying Survey Unit Mass Overall
YYYY/MM/DD Unit (g/unit) Content Flag
piece 2500.000

Note: “Overall content flag” is automatically displayed. It cannot be entered manually.

5.3 Entering Information on Material Composition of Products

In the basic information screen, click Input button for the row of the surveyed item you wish to enter, and
then move to the screen for entering the information on material composition (see the table below).

Surveying Survey Unit Mass Overall Input Copy Clear

Unit (g/unit) Content Flag | substances substances | substances
piece 2500.000 | Input Copy Clear
Input Copy Clear

Note: When you click Input, the following warning screen may be displayed.
This is because no information is entered to specify the surveyed item.

Click OK to move to the screen for entering the information on material composition of products.

Warning E|

Mone of the following information has been entered:
! Manutacturer Name,
Respondent's product/subparts/ material number,
requester's product/subpart number,
Material Grade Mo,
Metal Type JIS symbols,
Coloring Mo,
Thickness{mms,
Color,
and Diameter imm.
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Note: The screen for entering the information on material composition of products varies depending on the survey

response tools. These screens will be explained in detail in the following sections.

5.3.1 Survey Response Tool Format 1 (Standard Type) - Entering Information on Material Composition of

Products
As shown below, the basic information and surveyed item information displayed on the previous screen
are automatically displayed at the top of the screen.

Basic ion about Company/ Parts/ Products/ Material
R A Respondent's date [ oK ] [ CANCEL ] [ Error Check ] [ Error Confirmation ] [ Print ]
of data entry
[A100001 321
Requester's | Requesters | Requester's
Product/ Metal Type : : item1 Item2 item3
number of requester name of requester | Jissymbois | Coloring No. | Thickness(mm) Golor
[ABC-123-001 Large size Switch Unit
i | Respondents | Respondents | Respondents
Respondent's Respondent's ltem1 item2 item3 v Revision Dats | Surveying ” Content rate in homogeneous material:
Manufacturer Name v Data Version | v~ \ivipp Unit (glunit) If the same intended use classification
AL D applies to several application area, enter
the maximum value.
XXX Electronics [abc-123 [Switch Unit piece 2500.000 Itis indispensable only by level A.
Information about Substance contained in
Parts/ Products/ Material ALLN t
clsen Trrnod Lovl | ToalContnt Inended o ascaton D I —
cation Substance Groups econtent o) (Gheak appropeiate tame) i Purpose of usellntended use Application area content rate ovmpeation of prodaets
Lo N:Not Conten) (ppm)
Ca-J-99_Containing cadmium above 75pmm m]
Ca-J-0 Other intended use containing cadmium above 75ppm o
(‘Explain details n the right-hand side columns)
(Ca-R-0Other intended use containing 75ppm or less of cadmium o
(“Explain details n the right-hand side columns)
[Ca-R-1 Electric point and plating excluding uses banned by the amended EU Directive o
05 |Cadmium and Cadmium Compounds 76769/EEC “91/338/EEC”
Cd-R-2_:Optical glass, filter glass. [}
[Ca-R"3_:Cadmium in printing inks for the application of enamels on borosiicate glass 0
(Ca-E-1_Thick fim pastes 0
Cd-E-2_:Batteries for electric vehicles ]
[Ca-E-3_-Oplical components on glass used for Driver Assistance Systems ]
[CA-RE-98 ‘Containing 75ppm of less of cadmium : Impuriiesirecycled materials/contaminalion =]
C-J-99_Containing hexavalent chromium above 1000ppm ]
Cr-J-0-Other intended use containing hexavalent chromium above 1000ppm o
(‘Explain detais in the right-hand side columns)
Cr-R-0 :Other intended use containing 1000ppm or less of hexavalent chromium o
(‘Explain detais in the right-hand side columns)
Cr-R-1_:For the prevention of corrosion of carbon steel cooling system in absorption refrigerators. [m]
Cr-R-2 :Hexavalent chromium in corrosion preventive coatings of unpainted metal sheetings
A07 [Hexavalent Chromium Compounds and fasteners used for corrosion protection and Electromagnetic Interference Shielding o
in equipment falling under category three of Directive 2002/96/EC
(T and until 1 July 2007.
[CrE-1 “Anti-cormosion coalings =]
[Cr-E-2_:Corrosion preventive coating related to bolt and nut assembles for chassis applications m]
Cr-E-3_:(Absorption) refrigerators in molor caravans m]
Cr-RE-98 Containing 1000ppm or less of hexavalent chromium o
Impuritiesirecycled materials/contamination

(1) Click the “content flag by threshold level” column in each substance category to display the pull-down
menu. Make sure to choose either Y or N (entry is required in all the 24 substance categories).
You can also enter Y or N directly from your keyboard. Y and N are not case sensitive.

Refer to the content flag flow chart illustrated on p. 13 in Survey Response Manual for details on
determining Y or N.
Note 1: Levels A and B have different criteria for content flag.
Note 2: If the content flag is Y, answer all the items after (2) (some items are optional).

Note 3: Even when the content flag is N, if you know about the content, enter the total content amount,
intended use classification, and so on.

All N button:

Information about Substance contained in

Parts/ Products/ Material

ALL N

Level

Classifi
cation
No.

Substance Groups

Content Flag by
Threshold Level
(Y:Content /
N:Not Content)

Total Content
(mg)

- If you click All N button with all content flag columns blank in the 24 substance categories, all columns
for their content flag are automatically filled with N.

If you click All N button with Y already entered in one of the 24 substance categories, the following
warning appears.

JGPSSI Survey Response Tools Ver. 3 Operation Manual, March.12,2007 Third Edition

Y is entered in one or more substance groups,
Do vou wank bo enter N only in substance groups that are nok matked with ¥?

ALL N except ¥

ALL M{owverwrite)

12



If you click Yes, N is automatically entered in the content flag for substance categories excluding those
with Y already entered: “All N except Y”

If you click No, N is automatically entered in the content flag for all substance categories including those
with Y already entered: “All N (overwrite)”

(2) Enter the total content amount (mg) of chemical substances contained in the unit set in the “survey unit” on
the previous screen with two significant digits (third digit to be rounded). Although only the three decimal
places of total content amount are displayed, enter the accurate total content amount.

(If the content flag is Y, both Levels A and B require entry.)

[Display]

(Example) 2549 mg: 2500 mg  2500.000
1.1456 mg: 1.1 mg 1.100

0.00214 mg: 0.0021 mg 0.002

0.1 mg: 0.1mg 0.100

- Enter the greatest content amount that you know of.

- For the content amount of metal compounds, enter an amount converted into metal elements contained in
the compound rather than the compound amounts contained.
(Refer to the metal conversion factor in Exhibit 5: JIG Detailed Chemical List in Survey Response

Manual.)
Example:
e Content Flag by
Classifi
B —-" Substance Groups Thre.shold Level Total Content
No (Y:Content / (mg)
. N:Not Content)
AO05 |[Cadmium and Cadmium Compounds Y 490.000

(3) Choose an applicable item in the intended use classification displayed for each substance category.

- Click the box () in the applicable use column on the right of each item to display the check mark. (If
the content flag is Y, entry is required). See the example shown below.

- Choose all intended use classifications applicable for the surveyed item to display * symbol. The
description of intended use classification to be displayed on the screen is the same as the one for the
intended use classification in Survey Response Manual in Exhibits 2 and 3. Each item is coded and
defined.

“R” placed in the middle of this code means the RoHS directive, E the ELV directive, RE an item
associated to both directives.

If there is no detailed intended use classification applicable on the list, choose “other use” such as Cd-J-0,
and then describe it in the “additional information on material composition of products” column.
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Example

Intended use classification (* : appropriate
(Check appropriate items) item)

Cd-J-99 :Containing cadmium above 75pmm : Impurities/recycled materials/contamination

Cd-J-0 :Other intended use containing cadmium above 75ppm
(*Explain details in the right-hand side columns)

[

Cd-R-0 :Other intended use containing 75ppm or less of cadmium
(*Explain details in the right-hand side columns)

Cd-R-1 :Electric point and plating excluding uses banned by the amended EU Directive
76/769/EEC “91/338/EEC”

Cd-R-2 :Optical glass, filter glass

Cd-R-3 :Cadmium in printing inks for the application of enamels on borosilicate glass.
Cd-E-1 :Thick film pastes
Cd-E-2 :Batteries for electric vehicles

Cd-E-3 :Optical components on glass used for Driver Assistance Systems

OoOooo O] O

Cd-RE-98 :Containing 75ppm or less of cadmium : Impurities/recycled materials/contamination

(4) Entering Intended Use, Application Areas, Maximum Content Rate in Homogenous Material, and
Additional Information

- In the intended use column, briefly describe the intended use for the chemical substance.
Example 1: Stabilizer, plasticizer, colorant, flame retardant, rust inhibitor, soldering component, etc.
Example 2: Primary component, heat stabilizer, electrical property improvement, mechanical property
improvement, etc.

- “Application areas” refers to the area containing a surveyed chemical substance found in a subpart’s
component.
For the name of application area, write a name used in specifications or drawings, a name used by a
supplier, or a commonly used name. If multiple areas contain the same chemical substance, write its
primary application area followed by “etc.”
(Refer to p. 9 in Survey Response Manual and the examples of application in Exhibit 4.)

Note: The items marked with * symbol in the intended use classification requires input of an intended use
classification/purpose and an application area. The maximum character length of each item is up to
80 bytes .
- The maximum content rate in homogenous material (ppm). This is not a required entry.
For both Levels A and B, enter the content rate (ppm) in a homogeneous material found in the area
containing chemical substances. If multiple areas have the same intended use classification, enter the

greatest value.

- If there is additional information on material composition of products, enter in the additional information
column.

The maximum character length of each item is up to 80 bytes.

[Example]
Maximum - N A 3
Purpose of use/Intended use Application area content rate Stliferne] |nf9rmat|on @I ]
composition of products
(ppm)
Impurities in brass/Stabilizer im|Switch terminal/Resin frame 104
Stabilization/Anti-corrosion surf{Contact point/frame surface plati 152

As for brass, its content is controlled to the
RoHS standard (100ppm) or less

Note: Once you have entered information required in the all 24 substance categories, proceed to
“5.4 Error Check” on p. 18.
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5.3.2 Survey Response Tool Format 2 (Detailed Type) - Entering Information on Material Composition of

Products

As shown below, the basic information and surveyed item information displayed on the previous screen
are automatically displayed.

Basic Information about Company/ Parts/ Products/ Material

E— oata Format ver, | Respondents dat] (o ) (Coancer ) ((Emorcheck ) (Emor Contimaton | Pant )
Requester's Requester's Requester's
mmmmm 5 Metal Type ltem1 ltem2 ltem3.
number of equester name of requester Jis symbols | Coling No. | Thickness(mmf - Color
Respondent's | Respondent's [ Respondent's.
Respondents Respondent's tem1 llem2. ltem3 )
Manufacturer Name i Dataversion | SovseADas | Sueine | Suvey i ass
number materalname Content rate in homogeneous material:
Itis indispensable only by level A.
abc Inc. [XYZ001 | Switch A piece 2500.000
Information about Substance contained in
Parts/ Products/ Material
Content Flag by
3 Threshold Level Content Intended use classification (: appropriate » Content rate Addiional information on material
3 “,S:" Lz Ce) (Y:Content/ el [ Delete ] (mg) (Check appropriate items) (REGEDCRETETEIID orplcaton s (ppm) ‘composition of products
A7 [Hexavalent Chromium Compounds Add
A09 |Lead and Lead Compounds Add
'A10_|ercury and Mercury Compounds Add
A17_[Tributyl Tin Oxide (TBTO) Add
b R0
o e e
B05_|Polychiorinated Biphenyls (PCBs) Add
=
e
C02_|Azo Colorants Add
| e
| e i s
A02_|Arsenic and Arsenic Compounds Add
A03_|Beryllium and Beryllium Compounds Add
B07_|Vinyl Chioride Polymer (PVC) Add
B08_[Brominated Flame Retardants Add
*: The right hand-side columns in (*Explain details in the right-hand side columns) indicates "Purpose of use/Intended use", *Application area” and "Additional information on material composition of products".
(1) Click the “content flag by threshold level” column in each substance category to display the pull-down

menu. Make sure to choose either Y or N (entry is required in all the 24 substance categories).

You can also enter Y or N directly from your keyboard. Y and N are not case sensitive.

Refer to the content flag flow chart illustrated on p. 13 in Survey Response Manual for details on
determining Y or N.

Note 1: Levels A and B have different criteria for content flag.

Note 2: If the content flag is Y, answer all the items after (2).

Note 3: Even when the content flag is N, if you know about the content, enter the content amount, intended
use classification, and so on.

Note 4: For both Levels A and B, if multiple areas contain the same substance categories, click Add button
to add rows to enter information on material composition of products, and enter information on
each area. Click Add button to add a row.

Note 5: To delete data already entered, click the Delete column in the row in which you want to delete data.
When the pull-down menu is displayed, choose V. If you click Delete button with V displayed in
all rows you want to delete, all data in the rows selected is deleted. In the case of added rows, the
entire selected rows will be deleted (see the table below).

I
Classifi Content Flag by
cation Substance Groups Thre.shold o Add Delete Content
No (Y:Content / (mg)
i N:Not Content) || ——
Add
AO05 |Cadmium and Cadmium Compounds Y
v
\"
A07 |Hexavalent Chromium Compounds N Add
A09 |Lead and Lead Compounds Y Add
A10 |Mercury and Mercury Compounds N [ Add
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The maximum number of rows that can be added is 50 for the 24 substance categories. If you add more

than 50 rows, the following warning appears. In this case you cannot respond with the detailed tool.
Contact the survey requester for further instructions.

Microsoft Excel il

Mare than 50 lines are added.

All N button:

Information about Substance contained in ALLN
Parts/ Products/ Material

Classifi Content Flag by
cation Substance Groups Threshold Level Add Delete Content
No (Y:Content / (mg)
: N:Not Content)

- If you click All N button with all content flag columns blank in the 24 substance categories, all columns
for their content flag are automatically filled with N.

Level

- If you click All N button with Y already entered in one of the 24 substance categories, the following
warning appears.

Y is enkered in one or more substance groups,
Do wou wank o enter M only in substance groups that are not marked with %7

BLL M except ¥ ALL M{overwrite)

If you click Yes, N is automatically entered in the content flag in the substance categories excluding those
with Y already entered: “All N except Y”

If you click No, N is automatically entered in the content flag for all substance categories including those
with Y already entered: “All N (overwrite)”

(2) Enter the area’s content amount (mg) of chemical substances contained in the unit set in the “survey unit”
on the previous screen with two significant digits (third digit to be rounded). Although only the three
decimal places of content amount are displayed, enter the accurate content amount.

(If the content flag is Y, both Levels A and B require entry.)

[Display]

(Example) 2549 mg: 2500 mg  2500.000
1.1456 mg: 1.1 mg 1.100

0.00214 mg: 0.0021 mg 0.002

0.1 mg: 0.1mg 0.100
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- Enter the greatest content amount that you know of.

- For the content amount of metal compounds, enter an amount converted into metal elements contained in
the compound rather than the compound amounts contained.
(Refer to the metal conversion factor in Exhibit 5: JIG Detailed Chemical List in Survey Response
Manual.)

(3) If you click (or double-click) the right cell of “intended use classification” in which the area’s content

amount has been entered, a pull-down list of intended use classification appears. Choose an applicable
item. * symbol is displayed in the “applicable use” column. (If the content flag is Y, entry is required.)

- Choose all intended use classifications applicable for the surveyed item to display * symbol. The
description of intended use classification to be displayed on the screen is the same as the one for the
intended use classification in Survey Response Manual in Exhibits 2 and 3. Each item is coded and
defined.

“R” placed in the middle of this code means the RoHS directive, E the ELV directive, RE an item
associated to both directives.

If there is no detailed intended use classification applicable on the list, choose “other use” such as Cd-J-0,
and describe it in the “additional information on material composition of products” column.

Example: New rows are added.

Classifi Content Flag by
° Threshold Level Content Intended use classification (*: appropriate
Delet e
ci:':n ST SRS (Y:Content / Add clete (mg) (Check appropriate items) item)
5 N:Not Content)
Add Cd-J-99 :Containing cadmium above 75pmm : *
Cd-J-99 :Containing cadmium above 75pmm : *
A05  [Cadmium and Cadmium Compounds Y v Cd-J-0 :Other intended use containing cadmium above 75ppm (*Explain details in the right-hand side columns) *
v Cd-J-0 :Other intended use containing cadmium above 75ppm (*Explain details in the right-hand side columns) *
v
A07 |Hexavalent Chromium Compounds N Add Cr-RE-98 :Containing 1000ppm or less of chromium *
A09 |Lead and Lead Compounds Y Add Pb-R-2 :High-melting point solder (lead alloy containing above 85% of lead by weight) *
A0 |Mercury and Mercury Compounds N Add
A17 [Tributyl Tin Oxide (TBTO) N Add
A18 [Tributyl Tins & Triphenyl Tins N Add
B02 |Polybrominated Biphenyls (PBBs) N Add

(4) Entering Intended Use, Application Areas, Content Rate, and Additional Information

- In the intended use column, briefly describe the intended use of the chemical substance.
Example 1: Stabilizer, plasticizer, colorant, flame retardant, rust inhibitor, soldering component, etc.
Example 2: Primary component, heat stabilizer, electrical property improvement, mechanical property
improvement, etc.

- “Application areas” refers to the area containing a surveyed chemical substance found in a subpart’s
component.
For the name of application area, write a name used in specifications or drawings, a name used by a
supplier, or a commonly used name.
Refer to p. 9 in Survey Response Manual and the examples of application in Exhibit 4.

Note: Enter the area so that the homogenous material can easily be identified.

Note: The items marked with * symbol with the intended use classification specified require entry of an
intended use classification/purpose and an application area. The maximum character length of each
item is up to 80 bytes.

- Entering the content rate (ppm). Level A requires entry.
For both Levels A and B, enter the content rate (ppm) for the homogenous material found in the area
containing chemical substances.

- If there is additional information on material composition of products, enter in the additional information
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column.

The maximum character length of each item is up to 80 bytes.
Note: If characters exceed a cell width, they will be displayed running off the right end of the cell.

Example:
*: approprlate Purpose of use/intended use Application area Content rate Additional |nf_o_rmat|on on material
item) (ppm) composition of products

* Impurities in brass Switch terminal 90 [As for brass, its content is controlled to ####
* Stabilizer impurities Resin frame 104 |It is currently examined to control the content
* Stabilization Contact point 152 |It is currently examined to control the content
* Anti-corrosion surface treatmen{frame surface plating 85 |lt is currently examined to control the content
* Impurities from metal surface tr¢Chassis 30 [This substance does not require reporting, bu
* For jointing Component interior 850000

5.4 Error Check (same procedure for both tools)

Once you have entered the information required for the 24 substance categories, click the OK button at the
top of the screen. As shown below, you are prompted to choose whether you wish to run an error check.
Click Yes to run the error check. Click No to return to the former page (if you are creating the final
response, make sure to click Yes and run the error check).

Microsoft Excel ﬂ m El

Do wou want ko run an error checks

Erroris) Found.
It returns ko the Farmer page without the error check when [Mo] is pushed. |:>

- If an error is detected, the message “Error(s) found” is displayed.
- Click OK to display the error or warning description for the error check result.
The following is an example of an error check result.

- Click Back to go back to the previous screen. Correct the error, and run the error check again.

[ Error No.1015 ](A05/Cd-J-99)If [Intended use classification] is selected, please enter [Purpose of use/Intended use].

[ Error No.1015 ](A05/Cd-J-0)If [Intended use classification] is selected, please enter [Purpose of use/Intended use].

[ Error No.1016 ](A05/Cd-J-0)If [Intended use classification] is selected, please enter [Application area).

[ Warning No.2006 ](A07/Cr-RE-98)[Content (mg)] is not entered while [Content Flag by Threshold Level (Y/N)] is 'N' and [Intended use classification] is
[ Error No.1018 ](A09/Pb-R-2)If [Intended use classification] is selected, please enter [Content (ppm)] of the substance group that corresponds to Level A

- If no error/warning is detected, the screen returns to the basic information screen.

- If only a warning is found, the following screen appears.
Click Yes to display the warning description. Click No to return to the basic information screen.
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Microsoft Excel

5.5 Saving Content Entered in Survey Response Format (SAVE JGP)
(same procedure for both tools)

(1) If the error check finds no error/warning in the information on the screen of material composition of
products, the screen returns to the basic information screen. There, Y or N is automatically displayed in the

“overall content flag” column.

With the surveyed items, if one or more Ys are displayed in the content flag of the 24 substance categories,
Y is automatically displayed in the overall content flag. N is displayed in the overall content flag only
when all the content flags of the 24 substance categories are N (see the table below).
Note: Overall content flag is subject to error check.

Surveying Survey Unit Mass Overall Input Copy Clear
Unit (g/unit) Content Flag substances substances substances

piece 2500.000 N Input Copy Clear

Input Copvy I Clear

Input Copy I Clear

(2) Write comments regarding overall responses, if necessary, in the “additional information regarding survey
response” at the bottom of the respondent’s information section (see the table on the following page).
The maximum character length is up to 200 bytes.

a [ appyeP | | saveJeP |

[ Item Setting j [ Error Check J

[ Error Confirmation J

[Respondent's date of data entry (YYYY/MM/DD) | [2007/02/12
Respondent Information English
Company Name abc inc.

DUNS Number

FRERTRR

Address **** minato-ku, Tokyo
Division Name abc dept.
Contact Name Mike Md.

Telephone Number

03w aw

Fax Number

03w aw

|Email Address

XyzZ@Xxyz.com

Requester's management items 4

Requester's management items 5

Requester's management items 6

Additional information regarding survey responses

Although Level B substances do not require reporting.

(3) Make sure that the respondent’s date of data entry has been entered. This field is required. (See the table

above.)

If the data entered is incorrect, the following message appears. Click Retry to correct the incorrect data.

Microsoft Excel

Q The walue wou entered is not valid,
& user has restricked walues that can be entered into this cell,

Cancel |

x|
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(4) Click SAVE JGP button at the top of the screen. Then you will be asked to perform an error check, so
click Yes (see the picture below).
The error check checks both screens: the basic information screen; and the screen for
product/subparts/material information and material composition information.

Microsoft Excel

Caution: when you do not run the error check, please read the Caution: <Condition to save in jgp file>in 4.3.

(5) If the error check detects no error, a screen appears to choose a file to save (see the picture below).
(If an error is detected, correct the error and then click SAVE JGP again.)

- Choose a folder to save the file, and enter the file name in File Name and then click Save (see the picture
below).
FileSawve : i |
Saveir: | il JGPSSI =] = c¥ EE-

ABCO01-01.jgpl
ABCO01-02,jgpl
ABCO01-03.jgpl

File name: |#BCO01-014nd -1 Save |
Save as upe: I IJGF"I File=(*.jgp1] I LI Cancel /I
Z%

Note: As shown above, the file type of Format 1 (Standard Type) is automatically set to jpgl. The file type
of Format 2 (Detailed Type) is automatically set to jgp2.

When the following message is displayed, click OK. Now the jgp file is successfully saved.
x|

The file has been saved successfully,

5.6 Exiting Survey Response Tools

Choose File > Finish from the toolbar or Close.
When the following screen is displayed, click either Yes or No as appropriate.

Mo Cancel
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5.7 Sending jgp Files to Survey Requester
Send the jgp file in which the response data is entered to the requester by e-mail or by other means.

Note: As a rule, the requester and respondent should use jgp format to exchange data.

6. Data Conversion from Format 2 (Detailed Type) to Format 1 (Standard Type)
6.1 Data Conversion (from Detailed Type to Standard Type)
To convert data from a (Detailed Type) jgp2 file to a (Standard Type) jgp! file, load the jgp2 file with
Format 1 (Standard Type) Tool. In this case, set the file type to jgp2 at LOAD JGP and then load the jgp2
file.

If you click LOAD JGP, the following “Open File” screen appears.
Choose jgp2 for the file type. Next, choose a file with an extension of jgp2, and click Open.

21x]

Look jn: | 3 JGPSSI R I o e O e

ABCO02-22.igp2
ABCO0Z-23.jgp2
ABCO0Z-24.igp2

File name: j Open I
Files of ype: JGP2Files(* jgp2) | Cancel |

JGP1Fles].jap1]

When the following picture message, click OK to load the jgp2 file.

Microsoft Excel x|

Data will be converted, Please check the content after loading,
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6.2 Data Conversion (from Detailed Type to Standard Type) Restrictions

When loading the (Detailed Type) data in a jgp2 file with the Survey Response Tool (Standard Type),
restrictions apply. Data conversion is executed under the following conditions.

1) Data is converted when loading detailed data using a standard tool.
2) Specifically, substance category unit line and intended use/area unit line are converted.

Basic information line 1, basic information line 2, basic information line 3, and subparts unit line are

loaded without being changed.

3) Substance Group Unit Line

- The total content amount equals the sum total of the content amount entered for each substance
category.

- Additional information on material composition of products are incorporated with those with the same
intended use classification in the order of loading (maximum character length is 80 bytes, and those
exceeding it are truncated). *1, *2

4) Intended Use Classification/Subparts Unit Line

- The intended use classification/purpose and application areas are incorporated with those with the
same intended use classification in the order of loading (maximum character length is 80 bytes, and
those exceeding it are truncated). *1, *2

- The content rate should be the greatest value in the same intended use classification.

*1: Data is incorporated with a comma (single byte) placed between the data.
*2: When truncated, the last two bytes are entered as “>>" (two single-byte greater-than signs).

7. Loading Data in Old Format (Ver. 1 and Ver. 2 jgp files)

Both Standard Type and Detailed Type Survey Response Tools Ver. 3 can load data in a jgp file created
with Survey Response Tools Ver. 1 and Ver. 2 (restrictions apply to loading data).
In this case, set the file type to jgp at LOAD JGP and then load the jgp file.

If you click LOAD JGP, the following screen “Open File” appears.
Choose jgp for the file type. Next, choose a file with an extension of jgp, and click Open.

Open File d |
Lok in: | = JGPSSI | = &5 Ef-

Filez of lwpe: JGPFiles* jgp) ;I Cancel |
A

JGP1Files(*.jap1]
JGF2Files" jop

The following message appears. Click OK.
The data in the old format is loaded.
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Microsoft Excel X

2ld Format daka will be loaded, Please check the content after loading,

Note: Restrictions apply to data being loaded.
Basic information and information on surveyed items can be loaded, but in the old format only the content
amount (mg) can be loaded for the information on material composition of products.

From the old format data, automatically entered content amount or manually entered content amount
(whichever is the greater) is loaded as the total content amount.

8. Other Button Functions
8.1 Copy (see the table below)

If you click the Copy button, you can only copy lower-level data (information on material composition of
products) of the surveyed item in this line to a surveyed item in another line.

Surveying Survey Unit Mass Overall Input Copy Clear
Unit (g/unit) Content Flag | substances substances | substances
piece 2500.000 N Input Copy Clear

Input Copy Clear

Input Copv Clear
Procedure:
Click the Copy button in the data row to be copied, and enter the number to copy it to as shown below, and
then click OK.

The target row number can be specified by individual rows or consecutive rows. Individual rows should be
divided by a single-byte comma, and consecutive rows should use a single-byte hyphen.

Example: Copying the same data to row 15 from rows 2, 5 and 8.

Data Copy il
Please enter karget row mo. E
(From rowe 1 ko 1007,

Cancel |

|25.815

8.2 Clear

If you click Clear, the screen below appears. Click OK to erase only the lower-level data (information on
material composition of products) of the surveyed item in this line.

Surveying Survey Unit Mass Overall Input Copy Clear
Unit (g/unit) Content Flag | substances substances | substances
piece 2500.000 N ¢ Input L Copy Clear
¢ Input D¢ Copy Clear
¢ Input T Copy Clear
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Microsoft Excel x|

Do wou want to erase the surveved chemical substance data For the part in this rows

E Cancel |

8.3 Ascending & Descending (Sorting Surveyed Items and Overall Content Flag)

As shown below, click the Ascending or Descending button to sort the order displayed.

Ascen| [Desce AscenHDesce Ascen} [Desce Ascen] [Descd Ascerj EDeSCE"
i ) ' N : ; i ; ding nding
din, ndin ding ) | nding I ding ndmg-_ ding nding|
Respondent's
No AEIET subP;?t(;;(:tfarial b EMTEEEEL rodu?:t/sub arts Overall
: number of requester P Name P . P Content Flag
name of requester /material number
1
2
3
8.4 Sort

Displays a “Sort” screen where you can sort the order to display.

You can perform sorting based on surveyed items (other than those described in 8.3 above) serving as a
key.

As shown below, choose a sorting key phrase from the pull-down menu. You can set up to three keys in the
order of priority. Choose either Ascending or Descending and then click OK.

[Example]
st B
— 1=t priority key &
* Ascending
Froduct'subpart number of reguestaer o
I J " Descending
— 2nd priority key p
+ Ascendin
| Manufacturar Mame j .g
" Descending
— 3rd priority key -
Thicknessimm) j -
I " Descending
18 CARMCEL |
8.5 ADD JGP

Load additional jgp files. First choose a jgp file to load in the “Open File” screen. Basic information will
not be loaded.
As shown below, choose a file type and file name, and then click Open.
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Open File ﬂﬂ
Look jre |3 JGPSSI = = cF Ef-

ABCO0Z-22.igpZ
ABCO02-23.igp2
ABCO0Z-24.jgp2

Filz name:

Files of type:

If subparts data is entered, loading starts with the line after the largest line number.

Note: If no. 100 contains data, loading will not be performed. In this case, the screen below appears.
If the total number of additional subparts exceeds 100, the data up to 100 can be loaded but the
exceeding data will be ignored. In this case, too, the following screen appears.

& The number of subparks exceeded 100, Loading will be ended,

8.6 Change Entry Heading

If you click this button, the screen to change an entry heading appears as shown below. You can set the
item heading (requester’s management items, requester’s items, and respondent’s items).

- Enter additional information regarding the requester in requester’s management items 1-3, and use them
based on the setting created by the requester. Do not use them for other purposes. (Usage examples:
department code, business hub code, etc.)

- Requester’s management items 4-6 are set by the requester to manage information regarding a respondent.
Do not use them for other purposes. (Usage examples: business partner names, business partner codes,
etc.)

- Respondent items 1-3 are used by the respondent (respondent’s memorandum).

Note: Data entered in the change entry heading screen is not reflected in the jgp file.

The data entered is saved in the tool and the entered content will be displayed on the screen. Thus, it
is recommended to use a different file name for the tool for each requester.

JGPSSI Survey Response Tools Ver. 3 Operation Manual, March.12,2007 Third Edition P. 25



Example

Item Setting

Basic Information about Company

Requester's management items 1 [Division Code Requester's management items 4 [Supplier Code
Requester's management items 2 |Site Code Requester's management items 5
Requester's management items 3 Requester's management items 6

Information about Parts/ Products/ Material

Requester's ltem1 XYZ Respondent's ltem1
Requester's Item2 000 Respondent's _ltem2
Requester's ltem3 Respondent's Item3

Tool screen example (department code and business hub code are displayed as a result of above changes):

Basic Information about Company

Reference Number Data Format Ver. | 3.21 |
Date of Data Entry (YYYY/MM/DD)

Requester Information English
Company Name
DUNS Number
Division Name
Contact Name
Telephone Number
Fax Number

Email Address
Reguester's management items 1 § |Division Code
Requester’'s management items 2 | |Site Code

Requester's management items 3

8.7 Print Subparts List

Click this button on a screen containing basic information to display print preview and print.
You can print basic information and products/subparts/material information.

8.8 Print

Click this button on a screen containing information on material composition of products to display print
preview and print. You can print the information on material composition of products contained on the
display screen.

8.9 Error Check (Basic Information Screen)

Performs an error check regarding the entered data. Checks the survey content of basic information and
products/subparts/material information as well as survey content of material composition of products. If an
error/warning is detected, an error screen appears. If no error/warning is detected, the following screen
appears.

8.10 Error Display (Basic Information Screen)

The result of error check is displayed. This button does not start error check. Click the button to display the
result of an error check that had been previously performed.
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8.11 Error Check (Material Composition of Products Information Screen)
Performs an error check regarding the entered data. Checks the survey content of material composition of
products that is being displayed. If an error/warning is detected, an error screen appears.

8.12 Error Display (Material Composition of Products Information Screen)
The result of error check is displayed. This button does not start error check. Click the button to display the
result of an error check that had been previously performed.

8.13 CANCEL (Material Composition of Products Information Screen)
Discards the entered content and returns to the basic information and products/subparts/material
information screen. The content of the screen returns to the previous information when the screen

transferred from products/subparts/material information to information on material composition of
products.
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